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A. What is CellDesignerTM 

CellDesigner is a process diagram editor for drawing gene-regulatory and biochemical 
networks. Networks are drawn based on the process diagram, with graphical notation 
system proposed by Kitano, and are stored using the Systems Biology Markup Language 
(SBML), a standard for representing models of biochemical and gene-regulatory 
networks. Networks are able to link with simulation and other analysis packages 
through Systems Biology Workbench (SBW). 

 
SBML + SBGN + Simulation + Databases Connections = CellDesigner 

 

 

http://sbgn.org/�
http://sbml.org/�
http://sbml.org/�
http://128.208.17.155/research/sbwIntro.htm�
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1. CellDesigner Major Features 

 Easy-to-understand graphical notation (SBGN) 
 SBML-compliant (Level 2 Version 1) 
 Built-in simulator (SBML ODE Solver, Copasi) 

 See also: “Running CellDesigner Simulation with Control Panel – Quick 
Tutorial”, or ControlPanel40.pdf under the documents folder. 

 Integration with analysis tools and other simulators via SBW 2.x 
 Database connections 
 Intuitive user interface 
 Extensive description of Compartments, Species, Reactions, and Proteins 
 Export of images in PNG, SVG, JPG, and PDF formats 
 Support of Block Diagram (*Proto-type) 

 Extract the control relationship between Proteins from the pathway diagram. 
 Describe and Verify the Modifications/Activations Logic. 

 Plug-in development framework 
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2. CellDesigner and SBML 

SBML (Systems Biology Markup 
Language) is a machine readable 
format (XML) for representing 
computational models in systems 
biology. Over 100 software 
packages now support SBML.  Its 
focus is to describe the systems of 
biochemical reactions.  Models can 
also include compartments, events, 
rules and constraints. 

 
CellDesigner can read/write in 
SBML format with rich enhanced 
functions stored as SBML annotations. 

 
For details of SBML, please refer to http://sbml.org website. 

 
 
 

SBML format 
 

<?xml version=”1.0” encoding=”UTF-8”?> 
<sbml xmlns=”http://www.sbml.org/sbml/level1” level=”2” version=”1”> 
  <model name=”ATitle”> 
    <listOfCompartments> 
      <listOfSpecies> 
      </listOfSpecies> 
    </listOfCompartments> 
  </model> 
</sbml> 

 

http://sbml.org/�


CellDesignerTM Startup Guide 

9 

3. CellDesigner and Graphical Notation 

SBGN (Systems Biology Graphical Notation) is a graphical notation for representing 
biological interactions, such as protein-protein interactions and gene regulatory 
networks. 
 
Current discussions on SBGN focus on three graphical notations: process diagram, entity 
relationship diagram and activity flow. CellDesigner adopts the process diagram as its 
graphical notation. 

         
Pure SBML without notation          SBML with notation 

 

Glyphs used in the graphical notation of CellDesigner 
 See also: [Appendix 1 “Symbols and Expressions] for details on CellDesigner 

graphical notation 
For details of SBGN, please refer to http://sbgn.org website. 

http://sbml.org/�
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4. CellDesigner 4.0 Major Features 

CellDesigner 4.0 now supports an updated graphical notation which conforms to SBGN-1 
proposal, plug-in development framework, and overall GUI improvement. 
* Check http://celldesigner.org for details. 
 
Major new features and changes in CellDesigner 4.0 are as follows: 

 
 Enhanced Graphical Notation 

CellDesigner adopts and supports SBGN (Systems Biology Graphical Notation) 
Process Diagram Level 1 proposal (April 2008 draft). 

 Protein Residues enhancement 
 Protein / Complex Status, nested Complexes 
 Genes states enhancement 
 Reactions (Modifications, Boolean Logic Gate) 
 New symbols: Drug, Tag 

 Enhanced KineticLaw editing 
 MathML rendering 

 Simulation – Control Panel enhancement 
 Copasi integration 
 Solver selection in the ControlPanel : SOSlib and Copasi 
 Simulation results displayed in Table format 
 Show Scatter Plot 

 Export Species/Reactions information including Notes into CSV file 
 Validation of files when opening (libSBML3) 
 Native file chooser support for Mac OS X 
 Layout menu: automatic layout functionality (using yFiles layout library) 

layout automatically when retrieving a SBML file. 
 Enhanced Edit Functions 

 Macro Functions 
 Change colors of multiple Species/Reactions 
 Find All search menu added 
 Components on the list highlighted 
 List sorting function 
 Edit the position of the name of the Compartment display 
 Reaction ID displayed on screen 

 Plug-in Development 

 See also “Plugin Development Tutorial” 
 Layer Function to add text/mark over the model 

 

 Note: 
- Export of Pure Level 1 Version 1 is no more supported. 
- Windows 2000 is no more supported. 

 

http://celldesigner.org/�
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B. Startup Guide 

1. Installation and Startup 

1.1 Operating Environment 

The current version of CellDesigner requires Java5 Runtime Environment (J2SE 
Runtime Environment 5.0 or later) on Windows (XP or later) or Linux with X Window 
System (Fedora Core 4 or later). 
 
On Mac OS X 10.4 or later, Java 1.5.0_03 or later is required. On Mac OS X 10.3, Java 
1.4.2_05 or later is required. On Linux platform, due to the version of native libraries, 
Fedora Core 4 or later is recommended; some problems will arise if you use other than 
these. 
 
The installer includes JRE (Java Runtime Environment 1.5.0_07-b03), so you do not 
have to install Java before your installation. 
 
If SBW and its modules have already been installed, these modules are available. 
Especially time evolving simulation of the model being edited can be performed. 

1.2 Install SBW and SBW Modules 

If you are interested in time evolving simulation and analysis on biochemical networks, 
we recommend you to install the Systems Biology Workbench (SBW) and SBW-powered 
software before you install CellDesigner (*). 
Please check http://sys-bio.org/ and download the software from Software Downloads 
section. 
 
To install SBW and SBW-powered software, follow their installation instructions. 
 
If you would like to use CellDesigner alone right now, you can postpone this step until 
you need simulation and/or analysis. 
 

 Note: For details on SBW information, go to 
http://sys-bio.org/research/sbwIntro.htm 

1.3 Install CellDesigner 

The current release is distributed in archived installer package for each operating 
system. 
 

Windows:   CellDesigner-40-windows-installer.exe 
Mac OS X:  CellDesigner-4.0-osx-installer.zip 
Linux:  CellDesigner-4.0-linux-installer.bin 

 
While J2RE is required for CellDesigner to run, the installers include it. Therefore, you 
do not need to download or install J2RE. 

http://sys-bio.org/�
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1.3.1 Windows 

1. Double click CellDesigner-40-windows-installer.exe. 
The installer window should open, and follow the message therein. 

2. Follow the instruction of the installer.  
 

1.3.2 Mac OS X 

1. Double click CellDesigner-4.0-osx-installer.zip. 
The compressed installer should be recognized by Stuffit Expander and should 
automatically be expanded to CellDesigner-4.0-osx-installer. 

2. Then double click it. 
The installer window should open, and follow the message therein. 

 
1.3.3 Linux 

1. Open a shell and, cd to the directory where you downloaded the installer. 
2. At the prompt, type, 

% chmod u+x CellDesigner-4.0-linux-installer.bin 
% ./CellDesigner-4.0-linux-installer.bin 

3. The installer window should open, and follow the message therein. 
 
 Note: In case you have installed SBW 2.7.6 or later, and you encounter an error 

while installing CellDesigner, there might be a possibility that the C++ Broker 
is up which prevents CellDesigner to start. Please try to kill the broker using 
the Task Manager, or restart your system before you resume the CellDesigner 
installation. 

1.4 Installed File Images 

After installation is finished, you would see the following directories/files in the 
installation directory (/CellDesigner4.0 by default). 

 
+00README.txt 
| 
+CellDesigner4.0.exe executable application module (* Windows only) 
+CellDesigner4.0.sh executable application module (* Linux only) 
+CellDesigner4.0 executable application module (* Mac OS X only) 
| 
+/documents 
| +ControlPanel40.pdf quick tutorial for control panel 
| +PluginTutorial40.pdf quick tutorial for plug in 
| +StartupGuide40.pdf this document 
| +/plugin 
|   +index.html Plug-in document 
| 
+/exec 
| +autolayout_yobf.jar 
| +celldesigner.jar  library for CellDesigner application 
| +yObf.jar 
| 
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+/jre (1.5.0)  *(Windows, Linux only) 
| 
+/lib 
| +avalon-framework-4.1.4.jar 
| +batik.jar 
| +browserlauncher.jar 
| +copasi.jar 
| +copasi_gui.jar 
| +freehep-export-2.0.3.jar 
| +freehep-graphics2d-2.0.jar 
| +freehep-graphicsio-2.0.jar 
| +freehep-graphicsio-ps-2.0.jar 
| +freehep-io-2.0.1.jar 
| +freehep-swing-2.0.2.jar 
| +freehep-util-2.0.1.jar 
| +itext-1.4.6.jar 
| +jai_codec.jar 
| +jai_core.jar 
| +jcommon-1.0.0-pre2.jar 
| +jeuclid-2.0.jar 
| +jfreechart-1.0.0-pre2.jar 
| +mlibwrapper_jai.jar 
| +MRJAdapter.jar 
| +openide-lookup-1.9-patched-1.0.jar 
| +quaqua-filechooser-only.jar 
| +sbmlj.jar 
| +SBWCore.jar 
| +SOSlib.jar 
| +xercesImpl.jar 
| +xml-apis.jar 
| 
+libexpat.dll   *(Windows only) 
+libsbml.dll   *(Windows only) 
+sbmlj.dll   *(Windows only) 
+SOSlibJava.dll  *(Windows only) 
| 
+libexpat.so.1  *(Linux only) 
+libexpat.1.dylib  *(Linux only) 
+libsbml.so   *(Linux only) 
+libsbmlj.so   *(Linux only) 
+libSOSlib.so   *(Linux only) 
| 
+libexpat.1.dylib  *(Mac OS X only) 
+libquaqua.jnilib  *(Mac OS X only) 
+libsbml.dylib  *(Mac OS X only) 
+libsbmlj.jnilib  *(Mac OS X only) 
+libSOSlibJava.jnilib *(Mac OS X only) 
| 
+/licenses 
| +/celldesigner 
|   +license.txt 
| +/libraries 
|   +batik.LICENSE.txt 
|   +batik.NOTICE.txt 
|   +FreeHEP.LGPL.txt  
|   +FreeHEP.LICENSE.txt 
|   +itext-MPLICENSE.txt 
|   +jai.LICENSE.txt 
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|   +jfreechart.LICENSE.txt 
|   +libsbml.LICENSE.txt 
|   +mrjadapter.LICENSE.txt 
|   +quaqua.LICENSE.html 
|   +xerces.LICENSE.txt 
|   +xercesImpl.LICENSE.txt 
|   +xercesImpl.NOTICE.txt 
|   +xml-apis.LICENSE-SAX.html 
|   +xml-apis.LICENSE.DOM-documentation.html 
|   +xml-apis.LICENSE.DOM-software.html 
|   +xml-apis.LICENSE.txt 
|   +xml-apis.NOTICE.txt 
|   +yfiles-3rdPartyLicenses.html 
|   +yfiles-GeneralLicenseTerms.html 
|   +yfiles-GeneralTermsandConditions.html 
| 
+/Microsoft.VC80.CRT  *(Windows only) 
| +Microsoft.VC80.CRT.manifest 
| +msvcm80.dll 
| +msvcp80.dll 
| +msvcr80.dll 
| 
+/plugin compiled plugin jar files are added in this directory 
| +MappingArrayMass_plugin.jar 
| 
+/samples 
| +components40.xml  sample for various components 
| +database.xml sample for database connections 
| +M-Phase.xml  sample for model editing 
| +M-Phase2.xml  sample for model editing 
| +Macros.xml  sample for macros 
| +MAPK.xml  sample for simulation provided by SBML ODE Solver 
| +sim1.xml 
| +sim2.xml 
| +simulation.xml sample for simulation 
| +/nbt sample files used in Nature Biotech paper by Kitano 
| +/notation sample files for notation 
| +/plugin sample source and jar files for plugin 
| 
+ mmlctop2_0.xsl 
| 
+uninstall.exe  *(Windows only) 
+uninstall  *(Linux only) 
+Uninstaller  *(Mac OS X only) 
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1.5 Startup CellDesigner 

1.5.1 Windows 

1. Double click the shortcut icon for CellDesigner4.0  in your desktop. 
2. Or double click CellDesigner4.0.exe in the directory where you chose to 

install (C:/Program Files/CellDesigner4.0 by default). 
 

1.5.2 Mac OS X 

1. Double click the CellDesigner4.0 icon  in the folder you chose to install 
(/Application/CellDesigner4.0 by default). 

 
1.5.3 Linux 

1. On a shell, type ./runCellDesigner4.0 in your home directory. 
2. Or type ./runCellDesigner4.0 after changing to the directory where you 

chose to install (CellDesigner4.0 in you home directory by default). 

1.6 CellDesigner User Interface and Navigation 

CellDesigner consists of Menu, Tool bar, and the five areas as shown below 
 

 
 

Draw area: To draw a model. (also refer as “canvas” in this guide.) 
List area: To display and edit the list of the components, functions of 

a model 
Notes area To display and edit the notes of the component 
Tree area: To display all the list of the components in the tree 

structure. 
Layer area To display all the layers of the model. 

Menu 

Draw area

Tool bar 

Tree area 

Layer area 

List area Notes area
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1.6.1 To change the area size 

1. The size of the areas can be changed by dragging the borderlines. 
2. To maximize the area, click the triangle icons on the borders.  

(See the orange circles in the above screen.) 
 

1.6.2 To change the List and Notes areas position 

1. To switch the display position of the List and Notes areas,  
select View - List menu, then select Right or Down. 

 
1.6.3 To customize Tool bar 

1. Each group of the icons can be detached from the Tool bar. 
2. It can also be moved to the side (left or right) or the bottom of the main window 

by dragging the handle. 
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2. Quick Tutorial of Model Building 

This section is for beginners, and describes how to edit a model with CellDesigner in 
brief. 

 
A sample file “M-Phase.xml” is used in this tutorial since this model contains most of 
the essential CellDesigner's expressions of biochemical networks. 

2.1 Open a Sample Model 

1. Select File - Open in the Menu to open M-Phase.xml in the “samples” directory. 
2. A graphical network model is displayed on the Draw area. 

 
3. In the Menu, select File – Save as… to open the Save dialog. 
4. In the File name text box, type in a new name, e.g. “M-Phase_Test.xml”. 
5. Click Save. 
6. Drag the borders (left or right) of the Draw area to change the area size. 

 

 

2.2 Select a Component 

A Component is a general term for a Species, a Reaction, a Complex or a Compartment. 
Thus, any shape you see on the Draw area ---a rectangle, an oval, or a line segment--- is a 
Component. 
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2.2.1 To select a Component 

1. Confirm that Select Mode icon is highlighted. If not, click the arrow icon. 

 
2. Select a component in the Draw Area. For instance, select the green 

square-shaped Component labeled “CAK” which you will find in the upper left 
corner of the Draw area. This shape indicates that the Component is a Protein. 

 
3. Observe that the green square, a Protein, and also the linked line, called a 

Reaction, are highlighted. 

2.3 Move / Delete a Component 

1. Select a Species (e.g. a Protein) and drag it to see the linked Reactions follow as 
the Species moves. 

2. Delete the Species by the Delete key, and see the linked Reactions are deleted as 
well. 

3. To undo the deletion, select Edit – Undo in the Menu bar. 

2.4 Undo / Redo 

You can "undo" the previous actions by Ctrl-Z, and also "redo" after the undo by Ctrl-Y 
before saving the model. 
 
2.4.1 To undo or redo the previous action 

1. Undo by Ctrl-Z. 
2. Redo by Ctrl-Y. 

2.5 Change the Size of a Component 

1. When you select a Species or a Reaction, you will find small squares on it. These 
are the handles to change their size or to bend the line of the Reaction. 

2. Select one of the small squares and drag it. 

2.6 Compartment 

The shape with a thick (and yellow by default) border line is called a Compartment in 
SBML. 
 
A Compartment is a container for other Components. Since a Compartment is itself a 
Component, it can hold other Compartments inside. 
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2.6.1 To put Components in a Conpartment 

1. To select a Compartment, click on its border line. 
2. See the edge of the border line is turned into 

magenta and the Species inside are shadowed. 
3. A Compartment can hold Species and other Compartments inside. 
4. Drag the Compartment, and confirm that the Species inside follow it. 

2.7 Shape and Name of a Compartment 

A Compartment represents a generic bounded container, such as a cell or an intracellular 
compartment. Thus, notational change is only in visual, meaningless to semantics of 
biochemical and gene networks. 
 
2.7.1 To change the shape of a Compartment 

1. Select a Compartment.  
2. In the Menu, select Component – Change to OVAL.  

Observe the shape has changed to an oval. 
3. Select the Compartment again. 
4. In the Menu, select Component – Change to SQUARE and observe the shape has 

changed to a square. 
2.7.2 To change the position of the Compartment name 

1. Find the Compartment name which is initially located at the bottom of the 
Compartment. 

 Note: In the M-Phase_Test.xml sample model, you will find “cell” as the 
Compartment name. 

2. Select the Compartment name, drag and drop it wherever you want. 

2.8 Species and Reactions 

A Species represents, for example, a 
protein or some other molecule in a 
biochemical network, or a gene in a gene 
regulatory network. 
 
A Reaction represents a state transition of 
the connected Species such as a 
biochemical reaction, an interaction 
between proteins, and a regulatory 
relation between genes. 
 
The biochemical and genetic meanings of 
Species and Reactions are distinguished 
by their symbols. The list of all symbols 
that can be drawn using CellDesigner and 
their meanings are described in 
“Appendix 1: Symbols and Expressions”. 
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2.8.1 To change the symbol of a Species 

If you double click a Species or a Reaction, a dialog box will appear to alter its properties. 
 

1. Double click a Species, for example, “CAK”, then the Change identity of the species 
dialog box will be displayed. 

 
2. Change the value in the class drop-down menu. You can switch from Protein to 

Gene, RNA, Ion, etc., and vice versa. 
3. If necessary, type in a name the name text box. 
4. Click Apply button and see the shape has been changed. 

 
2.8.2 To change the symbols of Reactions 

1. Double click a Reaction. 
2. Change values in the dialog box, and see 

what have been changed after clicking 
Apply button. 

2.9 Activate a Species 

2.9.1 To activate a Species 

1. Select a Species. 
2. Type "a" on keyboard. 

Or, select Component – Set Active in the Menu. 
3. See the Species is wrapped by a dashed line. 

 
The dashed line has a somewhat ambiguous meaning, indicating only that the Species is 
“active” without referring to its targets. 
 

 See also “Appendix 1.1 “Basic Symbols”. 
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2.10 Close a Model 

2.10.1 To close a file without saving any changes. 

1. Select File – Close. 

2.11 Create a New Model 

2.11.1 To create a New Model 

1. Select File - New menu or press Ctrl-N. 
The New Document dialog will display. 

2. Specify Name, Width, and Height of a new model. 
3. Click OK. 

 Note: The name you specify here will be the file name when saved. 
e.g. If you specify "sample" here, the file name would be "sample.xml" 

 Note: Naming Convention 
The Model ID or/and the File Name only accept the following characters: 
(_|[a-z]|[A-Z])(_|[a-z]|[A-Z]|[0-9])*. No blank space is accepted. 
This is the SBML convention. 

2.12 Create a New Compartment, Species and Reactions 

If you want to create a new Species, Reaction, or Compartment, use icons on the tool bar. 
 See also “Appendix 1: Symbols and Expressions”. 

2.12.1 To create a new Compartment 

1. Click and select an icon from the Compartment tool bar (as shown below). 
 

2. Place your cursor on any point on the canvas, press and hold your left mouse 
button, and drag the cursor to make a Compartment of your favorite size.  
 

2.12.2 To create a new Species 

1. Click and select an icon from the Species tool bar (as shown below). 
2. Click a point on the canvas (draw area) where you want to place the new Species.  

 
 

2.12.3 To create a new Reaction 

1. Click and select an icon from the Reaction tool bar (as shown below). 
 

2. Depending on the type of Reaction you have chosen, follow the appropriate steps 
below. 
A. State Transitions - Connect between Species / Complexes 
B. Modifications     - Connect to a “Process Node” on a reaction 
C. Boolean Logic Gates - Show the relationship among the modifications 
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 See also: “A1.1.7 Logical Operation” 

2.12.4 To create a new Reaction - a State Transition <One to One type> 

1. On the Reaction Tool bar, click one of the following icons. (from left to right) 
 

-State Transition  
-Known Transition Omitted 
-Unknown Transition 
-Transcription 
-Translation 
-Transport 

2. Click a Species as the start-point. 
3. Click another Species as the end-point, and see a Reaction line has been drawn. 

 
2.12.5 To create a new Reaction - a State Transition <Two to One type> 

1. On the Reaction Tool bar, 
 

click the following icon. 
 

-Heterodimer Association 
2. Click a Species and then another for start-points. 
3. Click a Species for an end-point, and see a merged Reaction line is drawn. 

 
 
2.12.6 To create a new Reaction - a State Transition < One to Two type > 

1. On this tool bar, 
 

click one of the following icons. 
 

-Dissociation 
-Truncation 

2. Click a Species for a start-point. 
3. Click a Species and then another for end-points, and see a forked Reaction line is 

drawn. 
 



CellDesignerTM Startup Guide 

23 

2.12.7 To add a new Reactant to a Reaction 

1. On this tool bar, 
 

click the Add Reactant icon. 
 

2. Click a Species to start at. 
3. Place the cursor on a Reaction and find a blue point. 
4. Click on it, and see a Reaction line is drawn. 

 
2.12.8 To add a new Product to a Reaction 

1. On this tool bar, 
 

click the Add Product icon. 
 

2. Place the cursor on a Reaction and find a blue point. 
3. Click on it. 
4. Click a Species to end at, and see a Reaction line is drawn. 

 
2.12.9 To create a new Reaction ---a Modification 

1. On the Reaction Tool bar, click one of the following icons, 
 

-Catalysis 
-Unknown Catalysis 
-Inhibition 
-Unknown Inhibition 
-Physical Stimulation 
-Modulation 
-Trigger 

2. Click a Species for a start-point. 
3. Click a square (“process node”) on a Reaction for an end-point, and see a 

Reaction line is drawn. 
2.12.10 To create a Homodimer/ degradation / tag 

There are some icons with actions not mentioned above. 
Try the followings after selecting the icons and see what happens. 
 

1. To create a Homodimer Formation, click the Homodimer Formation icon , then 
click a target Species. 

2. To create a Degradation, click the Degradation icon , then click a target 
Species.. 

3. To create a Tag, click the Auto Create Tag icon , then click a target Species.. 
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2.12.11 To create a Boolean logic gates 

1. Draw two Species and connect them with a Reaction (State Transition). 

Or, on the Tool bar, click the State Transition macro icon.  

 
2. Draw two more Species. 
3. On the tool bar, click one of the icons below. 

 
4. Click the two Species painted last. 
5. Then click a square (“process node”) on the Reaction (State Transition), and see 

a Reaction line is drawn. 

 

2.13 Create a Complex 

2.13.1 To create a Complex 

1. Click a Complex icon on the tool bar. 

 
2. Move the cursor onto the canvas and click the left mouse button to place a 

Complex. 
3. In the Name of the species dialog box, type in a name of your choice. The name 

can be a simple name as well as a long name which includes the names of the 
species contained in the Complex, e.g. “Complex(ProteinA, ProteinB, ProteinC)”. 

4. To place Species in the Complex, just drag and drop them into the Complex. 

 
 
2.13.2 To modify the Species within a Complex 

1. Note: You can modify the individual Species inside a Complex box at any time. 
For example, you can add a residue, change the residue status, or change the 
name or the class of the Species. 

 Note: The Notes information of the individual Species will be maintained even 
though you move the Species in and out of the complex box. 

 See also: [3.4 “Add Notes to the Components”] and [4 “Edit Proteins”]. 
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2.14 Complexes and Reactions 

A Reaction can be connected to a Complex or to an individual Species/Reaction inside the 
Complex. Thus, you can distinguish if the activation is initiated by the Complex, or by an 
individual Species inside the Complex.  
 
2.14.1 To change the appearance of a Complex 

1. Select a Complex and type “C” to make it compact. 
2. Type the “C” key again to have the border line invisible. (no border) 
3. Type the “C” key again to get back to the original shape. 
4. You can do the same steps as above by selecting Component - Change Complex View 

menu. 
 

  
“normal” ”compact” 
 

 Note: You can set the Complex to be displayed with no border. This option is 
useful when you create a Complex with Gene/RNA/Antisense RNA. Below is an 
example which you can find in Complex40.xml in /samples/notation folder. 

 
 Note: A Complex can be contained within another Complex. Below is an 

example which you can find in components40.xml in /samples folder. 

   
a normal Complex a compacted 

Complex 
a Complex (the blue box) contained 

in another Complex 
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2.15 Edit Reactions 

2.15.1 To change connection points of Reaction on Species 

A Reaction can be connected to one of the 16 connection points around a Species. 
 

1. Select a Reaction and try to change the 
connection point. 

 
2.15.2 To add Anchor points 

You can add and remove Anchor points by the right click menu. 
1. Click a point on a Reaction where you 

want to add an anchor. 
2. Click the right mouse button and select 

Add Anchor Point. 
3. See a new anchor point has been added. 

 
4. To remove the anchor point, click the right 

mouse button on the target anchor, and then select Remove Anchor Point. 
 
2.15.3 To move a Species with a Reaction 

1. Select a Species with a Reaction attached, 
2. Move it around and see the last segment of the 

Reaction follow the Species. 
 
 

2.15.4 To change the shape of a Reaction line segment 

1. Select a Reaction 
2. Click the right mouse button and select To Orthogonal or To Polyline. 

 
Orthogonal 

 
Polyline 

 
2.15.5 To adjust a Reaction line automatically 

1. Select a Reaction which has already been 
set To Orthogonal. 

2. Right-click your mouse and select Adjust 

Connection in the menu. 
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2.15.6 To change line width and color setting of a Reaction 

1. Select a Reaction. 
2. Right-click on it and select Change Color & 

Shape… from the context menu. 
3. Change the color and line width. 

 Note: The color and line width of Species and Compartments can be changed in 
the same way.  

 
2.15.7 To make a reversible Reaction 

1. To make a Reaction reversible, double-click the Reaction 
2. On the Change property of the reaction dialog box, set Reversible option to True. 

 

2.16 Change Color and Shape of Components 

You can change the color and shape of a Component individually or collectively. 
 
2.16.1 To change the default settings of the color and shape 

1. In the Menu, select Preference – Components Color & Shape. 

 
2. Click the icon of the component whose color or shape you want to change. 
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2.16.2 To change the color and shape of the individual components 

1. Select the component(s) to edit, and then click the icon of  (Change Color & 

Shape) in the tool bar. 
2. In the Change color and shape dialog box, change the values as you like. 

 

2.17 Export Image 

2.17.1 To export the model image in PNG, JPEG, EPS, SVG or PDF format 

1. Select File – Export Image… on the Menu bar. 
2. Specify the name and the file format. 

 
 Note: The image saved here is the same as the one displayed on the screen. 

2.18 Save a Model 

CellDesigner stores all the information on the model you create to an SBML format file. 
 
2.18.1 To save a model 

1. Select File – Save or Save As…. 
 

 Note: CellDesigner's specific functions will be stored under <annotation> tag in 
the SBML file. 

 
2.18.2 To save a model in a pure SBML format 

1. Select File - Export Pure Level x Version x…. 
 

 Note: Naming Convention 
The Model ID or/and the File Name only accept the following characters: 
(_|[a-z]|[A-Z])(_|[a-z]|[A-Z]|[0-9])*. No blank space is accepted. 
This is the SBML convention. 
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2.19 Export and Import a Model in pure SBML format 

To open the xml file with another SBML-compliant application, you should 
export the model in a pure SBML file. 
 

2.19.1 To export the model on the canvas: 

1. Select File - Export Pure Level x Version x…. 
 

2.19.2 To import any SBML file: 

1. Select File - Open. 
 

 See also: http://sbml.org/ for more details on SBML Levels. 
 

CellDesigner's "export" / "SBML" functions: 

 CellDesigner stores all information only in a SBML file.  
 Though SBML does not support layout information, CellDesigner stores 

layout information inside <annotations> tags in SBML, which is 
CellDesigner specific extension.  

 Though these extensions are enclosed in <annotations> tags, generated 
SBML files are still "SBML Validated" documents.  

 CellDesigner has a feature to export "pure" SBML document which 
doesn't contain any layout information. You may use this feature if you 
find any trouble when you tried to open your SBML document with other 
SBML compliant software.  

2.20 Open an SBML File 

You can open an SBML file with CellDesigner.  
When you retrieve an SBML file created by some other tool than CellDesigner 
without any layout information, it will automatically adjust the layout of the 
model with the layout schemes. 

 
 See also: [5.11 “Automatic Layout”]. 
 

2.20.1 To open an SBML file: 

1. Select File - Open, then specify the target SBML file. 
 

 Note: You can also import the SBML models from BioModels.net database. 
(http://biomodels.net) 

 See also: [3.5 “Connect to Databases”]. 

http://sbml.org/�
http://biomodels.net/�
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3. Edit Species 

3.1 Edit Species 

A Species represents, for example, a Protein, a Complex or some other Molecule 
in a biochemical network, or a gene in a gene regulatory network. 
 

3.1.1 To edit a Species 

1. Right click on a Species 
2. Select a menu item from the right-click context 

menu. 
 Note: The third menu item (e.g. Edit Protein in 

the above screen) is content-dependent. The 
menu would be only displayed if the target 
Species is a Protein, a Genes, an RNA, or an 
asRNA. 

3. Change the values in the dialog box. 
 

 
Change Identity Edit Species Edit Protein 

 
Change Identity dialog can 
specify the class, name, 
type, modification, state 
of a Species. 

Edit Species dialog can 
view the id, name and 
compartment name in 
which Species resides, 
and set the value of 
initial amount / 
concentration, substance 
units, charge etc. 

Edit Protein dialog can 
specify name and type of 
a Protein, add residues 
or binding blocks and 
edit block diagram. 

 See also: CellDesigner.org Online Help Species section: 
               http://celldesigner.org/help/CDH_Species_T.html . 

 See also: [4 “Edit Proteins”]. 
 See also: [8 “Gene/RNA/AntisenseRNA Structure Expressions”]. 
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3.2 Check the Species in the List 

You can view all the data concerning a Species in the Species list. This is useful 
when you want to check all the items specified in the model.  
You can swap the column by drag-and-drop. 
 

 
 

 Note: If Species are contained in a Complex, only the 
Complex information will be displayed in the list and 
the Species will NOT. 
 

 
 
 

3.3 Export Lists to CSV file 

You can export the contents of the list into .CSV file format.  
All the other lists you can see in the List Area, such as the Protein list, the Reaction list, 
can be exported to a CSV file. 
 
3.3.1 To export the list 

1. Select the Species tab in the List 
area. 

2. Click Export button on the list or 
select File – Export List to CSV… from 
the menu bar. 
The Export Setting dialog will be displayed. 

3. In the Export Setting dialog box, check the data properties you 
want to export, then click OK. 

4. The file name is automatically specified as “xxx.csv” in the 
Save dialog. 

5. Click Save to save the CSV file. 
 

 Note: You may use other applications to check the contents 
of the CSV file. 
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3.4 Add Notes to the Components (Compartments, Species and Reactions) 

You can add a note to a component (Compartment, Species or Reaction,) except some 
Species types (Phenotype, Ion, Simple Molecule, Drug, Unknown and Tag). 
 
The Notes should be written in XHTML format. For details on XHTML tags and 
attributes, please check the XHTML 1.0 specification provided at 
http://www.w3.org/TR/xhtml1/ 
 
You can enter PubMed ID in the Notes, and directly link to the relevant reference. 
 

 See also [3.5 “Connect to Database”]. 
 
3.4.1 To add Notes to a component 

1. Select the target component. 
2. See that the Notes of the component is displayed in the Notes Area in the 

right-bottom corner of the window. 
3. On the target component, click on the right mouse button to display the popup 

menu and select <Compartment/Species/Reaction> Notes, or click Edit Notes button 
in the Notes Area. 

 Note: If your target component is a Species of the following types, namely, 
Protein, RNA, asRNA or Gene, you will also find <type of Species> Notes in the 
right-click menu or Edit <type of Species > Notes button in the Notes Area. 

4. See the <Compartment/Species/Reaction> Notes dialog pops up. 

 
5. Type the text you want to add in XHTML format. 
6. Click OK to close the dialog 
7. See the Notes information you have just added is displayed in the Notes Area. 

 

http://www.w3.org/TR/xhtml1/�
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3.5 Connect to Databases 

You can connect to the databases using the Species name or ID specified in the Notes. 
Currently we support the connections to the following databases. 
 

 DBGET  
(a simple database retrieval system for a diverse range of molecular biology databases.) 
http://www.genome.jp/dbget/ 

 SGD (Saacharomyces Genome Database)  
http://yeastgenome.org/ 

 iHOP (Information Hyperlinked over Proteins)  
http://www.ihop-net.org/UniPub/iHOP/ 

 Genome Network Platform  
http://genomenetwork.nig.ac.jp/public/sys/gnppub/portal.do 

 PubMed  
http://www.ncbi.nlm.nih.gov/sites/entrez 

 Entrez Gene  
http://www.ncbi.nlm.nih.gov/sites/entrez?db=gene 

 BioModels.net 
http://www.biomodels.net, http://www.ebi.ac.uk/biomodels/ 

 
3.5.1 To connect to the databases using Species Name 

1. Select the component (Species, Reaction or Compartment) 
2. Select the database to connect to: Database –  

Connect to SGD, Connect to DBGET, Connect to iHOP,  
Connect to Genome Network Platform,  
Connect to PubMed, or Connect to Entrez Gene. 

3. See your web browser pop up and open the page relevant to the Species. 
 

 Note: In case of DBGET, search is conducted according to the format of the 
name. If the name is written as "2.1.3.1", "EC2.1.3.1", "EC: 2.1.3.1", and "EC 
2.1.3.1" for EC number, while the name start with "C", "C00010", "C 00010", "C: 
00010" , search for compound ID. 

 
3.5.2 To connect to PubMed or Entrez Gene via the ID written in the Notes 

1. Specify the PubMed ID / Entrez Gene ID in the Notes of Species, Reaction, or 
Compartment as follows;  
PMID: 12345 PMID: 67890 
GeneID: 22954 GeneID: 493761 

2. Select the component (Species, Reaction or Compartment). 



CellDesignerTM Startup Guide 

34 

3. In the menu bar, select Database - Connect to PubMed. 

 
 

3.5.3 To connect to the databases to download the models 

CellDesigner can connect directly to BioModels.net, and import various 
annotated models. 

 
BioModels Database (http://biomodels.net) is a data resource that allows 
biologists to store, search and retrieve published mathematical models of 
biological interests. Models present in BioModels Database are annotated and 
linked to relevant data resources, such as publications, databases of compounds 
and pathways. 
 

1. Select the menu Database – Import model from BioModels.net… to retrieve a model. 

 

http://www.biomodels.net/�
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4. Edit Proteins 

In this section, how to edit proteins with modification sites, such as "Cdc2" in the sample 
“M-Phase2.xml”, is being described. 

 
With CellDesigner, you can edit symbols of proteins with modification residues on a 
network diagram, and hence, describe detailed state transitions between Species of an 
identical protein with different modifications. The structure of modification residues, 
states, and state transitions of proteins are also stored in SBML Level 2 format with 
CellDesigner’s extended tags. 

 
The model M-Phase2.xml, you see, describes state transition of "Cdc2," where there are 
five "Cdc2"s. The five represent different Species, while essentially the same protein. 
Therefore, CellDesigner should handle data structure describing each protein in a model, 
so that several protein-type Species could have references to the same protein data. This 
data structure is called “Protein”. 

4.1 Check and Change Protein Property 

You can see this Protein data by selecting the Proteins 
tab in the List Area. 
 
If you cannot see the Proteins tab, click on the right 
arrow in the upper right corner of the List Area, and 
adjust the size of the List window appropriately. 
 
For individual Protein, you can view the properties by clicking on the target Species to 
open a Protein dialog. In the dialog, you can edit properties of Protein, such as name, type, 
and residues and binding regions (add, edit, and delete). 
 

 Note: Changes in this dialog will be reflected to all Species referring to this 
Protein, including those inside Complexes. 

 
4.1.1 To edit the Protein property 

1. Select "Cdc2" in the list and click Edit button. 
Alternatively, you can click on the target 
Protein with the right mouse button, to select 
Edit Protein… menu. 
The Protein dialog will appear. 

2. Select type of a Protein. 
- GENERIC 
- RECEPTOR 
- ION_CHANNEL 
- TRUNCATED 
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4.2 Add Residue / Binding Region to a Protein 

The residues or binding regions of a protein can be added 
/ delete in the Protein dialog. You can adjust the position of 
the residues and regions in the dialog. However, to change 
the modification of the residue status (such as 
phosphorylated, etc.) should be made in the Species’ 
identity dialog. 
 
4.2.1 To add a residue to a Protein 

1. Open a Edit Protein dialog. 
2. Click add, edit button to add / edit a residue/region. 
3. You can select the type from residue or binding region, 

name it, and set the properties such as size and 
position. 

 
You can also delete a residue or a binding region in this 
dialog. 

 
 Note: Changes in this dialog will be reflected 

to all Species referring to this Protein, 
including those inside Complexes. 

 
4.2.2 To specify the modification of a residue 

Once you add a residue to a Protein, you can specify the 
modification status for a specific alias. As you specify the 
status per Species, use Change identity of the Species 
dialog instead of Protein dialog. 
 

1. Double-click a Species to open Change identity of 

the species dialog. 
2. In the dialog, click on the target residue in residues/regions 

diagram in the middle. 
3. Change the modification type in the modification drop-down 

menu. 
Phosphorylated Palmtoylated 
Acetylated Prenylated 
Ubiqutinated Protonated 
Methylated Sulfated 
Hydoxylated Empty 
Glycosylated Don’t care 
Myristoylated Unknown 

 
 Note: You cannot add, edit, or delete modification residues 

in this Change identity of the species dialog. To add/ delete a 
residue, use Edit Protein dialog instead. 
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4.3 State of Proteins 

The state of the protein can be changed to Open / Close / User defined text. Here 
again, you will use Change identity of the Species dialog instead of Protein dialog. 
 

4.3.1 To specify the modification of a residue 

1. Double-click a Species to open Change identity of the species dialog. 
2. In the dialog, select state from the drop-down menu. 

4.4 Block Diagram –to check Relationship of a Species (*Proto-type) 

Block diagram gives a summary view of interactions with respect to a specific Species 
(especially Protein) and relation between its modification and activity as enzyme. Using 
this block diagram editor, complex relations between Proteins can be understood at a 
glance and the relation between modification states enzymic activity can easily be 
constructed. 
 

 Note: The editor is still prototype and user interface for edittin is not fully 
functional. 

 
4.4.1 To extract Regulation 

CellDesigner extracts the interactions where the 
Species regulates or is regulated by other Species, 
from process diagram, and displays its block diagram.  

  
1. Open M-Phase.xml. 
2. Right click on Species “Cdc2” then select Edit 

Protein menu. (See [4.1]). 
3. Click edit block diagram button and you can 

see the diagram as shown below. 
 

At the top side of the rectangle placed in 
center, states of modification residues of 
Cdc2 and proteins that cause change of the 
states (phosphorylate or dephosphorylate) 
are shown. At the left and bottom sides, 
binding to CyclinB enzymic activity to 
Lamina are shown respectively.  
 

 See also Kitano (Biosilico 1, No.5 (2003) pp.169—176), For notation details of 
the block diagram. 

 
List in the dialog shows all the Species of Cdc2 and Complexes with other 
Species in process diagram (column) and their modification states and enzymic 
activity (row).  
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4.4.2 Modifications/Activations Relation 

You can edit logical relation between modification states and enzymic activity.  
 

1. Select the symbol “&” and then place them on the diagram.  
2. Select the arrow, and link “P”, “&”, “□” and “■”. 
3. To delete a placed symbol, select the symbol and press × button in the toolbar. 

 Note: The arrows represent causal relationship and “&” , “|”, etc. are logical 
operators. Created logical relation can also be verified by checking consistency 
with contents of process diagram.  

4. Press verify button. 
5. Enzymic activity fields inconsistent with edited logical relation are highlighted 

in red. 
 

  
 
The above figures, the left is depicted by logical relation inferred by Species s29 
only and the enzimic activity field of Species s28 is highlighted. The right is 
corrected by using the information of s28. (Note that the way of correction is not 
unique.) 
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5. Draw a Model using the Edit Menu 

In this section, convenient functions for editing models are introduced. 
CellDesigner provides several functions that are generally seen in drawing software. 

5.1 Cut, Copy and Paste 

5.1.1 To cut and paste a Species 

1. Select a Species by clicking on it. 

 
2. On the Edit menu, click Cut. Or type Ctrl-X. 

The Species has been cut. 
3. On the Edit menu, click Paste. 

The Species reappears. 
4. In the Notes area, observe that the Notes content is the same as the original. 

 
5.1.2 To copy and paste a Species 

1. Select a Species by clicking on it. 

 
2. On the Edit menu, click Copy. Or type Ctrl-C. 
3. Paste it on the canvas by selecting Edit – Paste, or typing Ctrl-V. 
4. In the Notes area, observe that the Notes content is the same as the original. 

 
5.1.3 To change the identity of a Species 

1. Right click on one of the Species shown in the previous procedure, and select 
Change Identity. 

2. If Residues Caution dialog appears, click Close. 
The Change identity of the species dialog appears. 

3. In the protein list, click New Protein. 
4. In the name textbox, type any name, i.e. “mySpecies”. Click Apply. 
5. Click No. The name of the Species has been changed to “mySpecies”. 

Its id has also been changed but not shown. 

  
6. In the List Area, select Species tab. 

See that the id and name of the Species has been changed.  
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7. In the List Area, select Proteins tab. 
See that the id (as a protein) and name of the Species has been changed. 

 
 

5.1.4 SpeciesAlias 

The copy-and-paste action makes “real” copies of the selected Species, which are 
SpeciesAliases in CellDesigner’s terminology, referring to the original Species. 
Strictly speaking, all of the Species on the canvas are SpeciesAliases, each 
referring to the original Species. By this feature, CellDesigner has multiple 
copies of the same Species on the canvas (i.e. a model), to possess ability to make 
various expression of a network. 

 
 
When you have created a new Species, what you see on the canvas is not the Species 
itself but an Alias of it. 
 
5.1.5 To see the relationship between a Species and a SpeciesAlias in XML 

1. In the Menu, click File – New to create a new model. 
2. Click on any type of Species icon from the Tool bar and place it on the canvas. 

 
3. Move the cursor and click anywhere on the canvas to place the Species you have 

chosen. Now you have the simplest model on your canvas. 

 
4. Select File – Save as… in the Menu. 
5. Save the file in XML format. 
6. With a web browser, open the XML file you have just saved. 
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7. Find the <celldesigner:listOfSpeciesAliases> tag, under which is a child 
element that specifies the Alias of the Species. <celldesigner:speciesAlias 
id="sa1" species="s1"> 

8. Near the bottom of the XML file, find the <listOfSpecies> tag which lists up 
all the Species in your model. 

9. Find a tag as below which indicates the Species itself. 
<species id="s1" name="s1" compartment="default" initialAmount="0"> 

 
 Note: A Complex is a type of Species but a ComplexSpeciesAlias is NOT a 

SpeciesAlias. 

5.2 Select Mode  

After you have put a new component on canvas, the Select Mode icon  will 
automatically be selected so that you can immediately select and move the component. 
This is the initial setting of CellDesigner.  

 
You might want to change this setting so as to create several components on canvas first 
and then rearrange them as you like. 

 
5.2.1 To avioid the automatic Select Mode 

1. Select Edit menu in the Menu. 
2. Select Input Repeat. 
 

5.2.2 To switch temporarily to the Select Mode 

1. While the Select Mode icon  is NOT selected, hold down the “s” key on 
your keyboard. 

2. Select a Component and move it. 
3. Release the “s” key to go back to the previous mode. 

5.3 Select All 

5.3.1 To select all the components 

1. Select Edit and then Select All in the Menu  
2. You can also use Ctrl-A. 

5.4 Grouping 

In Select Mode, by clicking multiple Species while holding the SHIFT key down, you can 
make a temporal group of the selected Species. Moving, cutting, and copying them in a 
group are available. If you want the group to be permanent (saved to SBML), use Ctrl-G 
while the temporary group is formed. This grouping feature is resembled to the situation, 
Species on a Compartment, while it has nothing to do with structure of the model. 
Therefore, if these two conflict each other in the canvas, “Species on a Compartment” 
structure has priority. 
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5.4.1 To create a temporary group of components 

1. Click multiple Species while holding the SHIFT key down. 
2. You can move, cut or copy them together. 

 
5.4.2 To create a permanent group of components 

1. Click multiple Species while holding the SHIFT key down. 
2. Select Edit and then Create Group in the Menu. Or use Ctrl-G. 
3. When saved, this group information will be written in the SBML file. 

5.5 Alignment 

5.5.1 To adjust the alignment of the components 

1. Select the multiple Species you want to adjust. 
2. Click Edit menu, point to Alignment, and select an alignment type. 

You can also click an icon in the Tool bar. 
        

 
5.5.2 To adjust the position of a component by keyboard operation 

1. Select a component. 
2. Use UP, DOWN, RIGHT, LEFT keys to move the component pixel by pixel. 

5.6 Set Grid Snap ON/OFF 

Snapping your components on the grid makes it easier to layout the pathway diagram. 
 
5.6.1 To use Grid Snap 

1. On the Edit menu, click Grid Snap. 
2. To show the grid, click Grid Visible on the Edit menu. 
3. To change the grid size, click Set Grid Size... on the Edit menu. 

5.7 Zoom IN/OUT, Bird’s Eye View 

You can change the view of the model by clicking the following icons. 

 
 
When you create a big model, it would be convenient to 
use the Bird’s Eye View to navigate inside the model. 
 
The Bird’s Eye View can be displayed by clicking the icon 

 (Show Bird’s Eye View) in the above Tool bar. When you 
drag the red square in the Bird’s Eye View, observe that 
the view of the Draw area moves accordingly. 
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5.8 Change Color and Shape 

You can change the color and size of the 
components, such as Species, Reactions 
and Compartments, individually or to 
their default settings. 

 
5.8.1 To change the default settings 

1. On the Preference menu, select 
Components Color & Shape.... 

2. In the Default Component Setting dialog, 
click on a Species of which you want to 
change the default settings. 

3. In the Default setting of <species name> 
dialog, change parameters. 

 
5.8.2 To change the color and shape of the individual component(s) 

1. Select a component, or components of the same type. 
2. In the Component menu, select Change Color & Shape..., or Click the Change Color & 

Shape icon  in the tool bar. 

5.9 Display special characters in Component name 

As CellDesigner is compliant with SBML, all names of components in a model must 
conform to the SBML convention. CellDesigner 4.0 is compliant with SBML Level 2 
Version 1; any character that can be mapped to UTF-8 encoding can be used for the 
component names. If you want the special characters, such as + plus, line break, 
superscript and subscript, you should follow the special rules to input such characters.   
 
5.9.1 Examples 

A special character is expressed by a sequence of characters with precedent and follow up 
'_'s. Here are some examples:  
 
1) Ca2+ ("Ca" with "2+" superscript) 

Ca_super_2_plus__endsuper_ 
Ca_super_2+_endsuper_ 

 
2) G alpha beta gamma ("G" with Greek "αβγ" subscripts) 

G_sub__alpha__beta__gamma__endsub_ 
G_sub_αβγ_endsub_ 

 
3) Complex of Cdc2 and CyclinB ("Cdc2" followed by "+CyclinB" in the new line). 

Cdc2_br__plus_CyclinB 
Cdc2_br_+CyclinB 

 
For more details on displaying special characters, click Name Expression in the 
Help menu. 
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 Note: CellDesigner uses the "name" attributes as information to distinguish 

Species. Therefore, even if the rendered names look the same, the different 
"name" attributes, for example, "Gα" and "G_alpha_", mean different Species. 

5.10 Macros 

To draw the diagram easier, some of the most frequently used components sets 
are available as “macros”. You can select the macros from the tool bar to draw 
the following components set.  

 
 
5.10.1 To view how each macro paint the components 

1. In the File menu, click Open. 
2. In the Open dialog, go to “samples” folder in your CellDesigner directory. 
3. Double-click “Macro.xml” in the “samples” directory. 
 

 
“Macros.xml” in the “samples” folder  
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5.10.2 To change the Macro Set 

1. In the Preference menu, click Set Macro UI... 
2. In the Macro UI Setting dialog, change the settings. 

5.11 Automatic Layout 

Automatic layout function is available for adjusting the model outlook.  
 

When you retrieve SBML files without any layout information created by other tools, 
CellDesigner will automatically adjust the layout with its layout schemes. 

 
5.11.1 To change the layout of your working model 

1. On the Layout menu, select one of the layout types 
Orthogonal Layout 

Organic Layout 

Smart Organic Layout 

Hierarchic Layout 

Incremental Hierarchic Layout 

Circular Layout 

Tree Layout 

Edge Router 

 
You can change the detail settings for the above types as well as default settings adopted 
when you retrieve SBML files. 

 
The default setting is Smart Organic Layout. 

 
5.11.2 To change the Default Setting: 

1. On the Layout menu, click Default Automatic Graph Layout. 
2. Select a layout you want set as default. 
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6. Reaction and KineticLaw 

6.1 Reaction ID 

6.1.1 To show Reaction ID on canvas 

1. On the View menu, select Show Reaction ID. 

 
          with Reaction IDs   without Reaction ID 

6.2 Reactions List 

You can view all the data concerning a Reaction in the Reactions tab in the List area. This 
is useful when you want to check all the items specified in the model. 
 
You can swap columns by drag-and-drop. 
 

 
 
You can export the contents of the list into .CSV file format by clicking Export button on 
the top of the list. 
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6.3 KineticLaw 

You can specify a KineticLaw to a Reaction using the KineticLaw dialog. You can input 
your own math functions, or you can use the predefined functions from the KineticLaw 

dialog. 
 
6.3.1 To add a KineticLaw to a Reaction 

1. Create a model with Proteins A and B, with State Transition reaction in-between. 
Or, just open the file sim1.xml in the samples folder. 

 
2. In the List area, click on the Species tab. 
3. Select the row for the protein A. 
4. Double click on the cell under InitialQuantity column. 
5. Set the value to “0.1”. 

 
6. In the List area, click on the Reactions tab and double click on the 

STATE_TRANSITION reaction to open the Reaction dialog 
7. Click KineticLaw Create button or Edit button. 

Or click on the Reaction with the right mouse 
button, then select Edit KineticLaw… menu. 

8. The KineticLaw dialog will open. 
9. In the middle of the dialog, click 

Mass_Action_Kinetics in the Predefined Functions 
pane. 

 
10. The Formula dialog will be displayed. 

 
11. Type in “0.3” in the k text box, then click OK. 
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12. See that “sn*kn” has been entered in math field, then click Update, then Close. 

 
13. In the Reaction dialog, click Close. 

 
The KineticLaw was successfully set to the Reaction. 
Now you can run the simulation. 
 
6.3.2 To run the simulation 

1. Do the previous walkthrough “To add a KineticLaw to a Reaction”. 
2. On the Simulation menu, click Control Panel. 
3. In the ControlPanel <filename> dialog, set End Time to “20”. 
4. Click Execute button. You will obtain a graph like this. 
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7. Simulation 

This section describes how to simulate a model. 
 

CellDesigner can be used as a kind of SBML file editors for simulators. 
There are two ways to conduct the simulation by CellDesigner:  

• using Simulation menu to call SBML ODE Solver seamlessly. The conditions 
can be set using the Control Panel directly. 

• using SBW menu to call SBML compliant simulators. 
 

 
 

Simulation menu  
for direct control over SBML ODE Solver 

SBW menu  
to call SBML compliant simulator. 

 
If you select the Simulation menu, you can call SBML ODE Solver directly. The 
ControlPanel enables you to specify the details of parameters, changing amount, 
conducting parameter search, and interactive simulation with intuitive manner. 
 
If you select SBW menu, you can pass the SBML data from CellDesigner to the SBML 
compliant simulators via SBW. You can conduct simulation seamlessly from CellDesigner 
via SBW to evoke such SBML compliant simulators. 
 

 Note: You need to set up SBW before you conduct simulation. 
 
To conduct time evolving simulation, you also need to know some basics of the SBML 
specification. Here in this document, describes the minimum requirements for 
simulation. 

 Note: There are various annotated sample models at BioModels.net for 
simulation. 

 See also: for more details on SBML specifications, 
http://sbml.org/Documents/Specifications 

 See also: [Section 3.5 “Connect to Database”]. 

http://sbml.org/Documents/Specifications�
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7.1 Simulation by Control Panel 

7.1.1 To simulate a model using the Control Panel 

1. Open the sample file “MAPK.xml” in the “samples” folder. 
2. In the Menu, select Simulation - Control Panel. 
3. The Control Panel will open. 
4. Change the End Time value to “1000”. 
5. Click Execute button. 
6. You will see the time course plot in the right side of the control panel. 

 
 See also: 

For more details on how to use control panel, please refer to the document 
“Running CellDesignerTM Simulation with ControlPanel” in the /documents 
directory. 

7.1.2 To change the solver to COPASI 

1. Click the COPASI radio button. 
2. Click Execute 
 

7.1.3 To convert the graph to a scatter plot 

1. In the ControlPanel, select 
any two Species by ticking 
the checkboxes in the Visible 
column.). 

2. Observe that the graph has 
been reduced to two curves. 

3. Tick the show scatter plot 
checkbox. 

4. Observe that in the new 
graph the x-axis does not 
indicate time series any 
more. 

5. Select the reverse checkbox 
to change the x- and y- 
axes. 
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7.2 Simulation by SBW 

If you want to simulate the model with SBW modules you need to check if the SBW and 
SBW-powered simulator modules are installed in the path mentioned in “Section 1.2 
Install SBW and SBW Modules”. 
 
7.2.1 To set up SBW for simulation 

1. To check if the SBW is properly installed, start CellDesigner and open a model. 
The SBW menu in the main Menu should be activated if your setup has correctly 
been done. 

2. Check if there are any simulators listed in the SBW menu. 
3. If you have installed the simulators of your choice correctly, they are listed 

under SBW menu.  

 Note: "Jarnac Simulation Service" appears if Jarnac has been installed. The 
others are default-installed.  

7.2.2 To simulate a model using SBW 

1. Open the sample file MAPK.xml in "samples" directory. 
2. In the Menu, select SBW – Jarnac Simulation Service. This wakes Jarnac up. 
3. Check the help or manual of the simulator to learn how to start the simulation. 

7.3 Data required for Simulation 

In terms of SBML model building, you should specify first at least some Species and its 
attributes, and Reaction and its attribute for simulation. The minimum requirement of 
their attributes might be: 
 
Species:  -initialAmount (default=0.0), 
Reaction:  -reactant:  -SpeciesReference: -stoichiometry (default=1), 
  -product:  -SpeciesReference:  -stoichiometry (default=1), 
  -kineticLaw:  -formula, 
    -parameter, 

 Note: the rightmost of each line is required to be input. 
 
7.3.1 Species Attributes 

The attribute “initialAmount” should usually be changed to a positive value.  
The attribute “formula” should be text string according to SBML Level 2 
specification, probably including id (name in SBML Level 2) attribute of Species 
and parameters defined by the attribute “parameter.” These attributes can be 
set at the Species list shown in the List Area. 

 
7.3.2 Reaction Attributes 

The attributes and parameters of the Reaction can be specified at the Reaction 
dialog and their child dialogs.  
 
For the other parameters, the default values specified in SBML Level 2 are used. 
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7.4 Data for Simulation: Sample MAPK.xml 

Let us use the sample file “MAPK.xml” to see how the data required for simulation is 
specified in the model. 

 
7.4.1 To check the data required for simulation 

1. Open MAPK.xml in “samples” directory. 

 
2. Select the Species tab in the List area and observe the initial quantities. 

 
3. Check the Reactions tab in the List area to see how the kinetic laws and 

parameters are specified. 

 
4. In the Reactions list, double-click on the third row whose id is “J2”. 
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5. The Reaction dialog will open. 

 
 

6. You can also open the Reaction dialog 
by clicking on the Reaction on canvas 
with the right-mouse button, then 
select Edit Reaction... menu. If the 
Reaction ID is not displayed on canvas, 
select View – Show Reaction Id in the 
Menu. 
 

 
 
 
 
 
 

7. Click Edit to display KineticLaw dialog. 

 
8. In the math text box, you can change the formula. 
9. In the Parameters tab, you can change the parameter values. 
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 Note: Ticking Name checkbox will show the variables in the math text box in 
Species name rather than Species ID. 

 
 Note: Ticking Math checkbox will show the variables in the math text box in 

fractional representation. 

 
 
7.4.2 To add a Species ID in the math text box 

1. In the SelectedReaction pane, select the target Species (e.g. MKK_P). 

 
2. In the math text box, put the cursor to the place where you want to add the 

Species ID. 

 
 Note: Verify that the Math checkbox is NOT selected, otherwise you cannot edit 

the math expression. 
 

3. Press the copy button. 
4. Observe that the Species ID has been added. 

 
 
7.4.3 To edit parameters 

1. Click on the Parameters tab at the bottom of the KineticLaw dialog. 
2. All the parameters related to the selected Reaction are listed. 

 
 
7.4.4 To specify Predefined Function 
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You can use some predefined functions such as Mass Action or irreversible simple 
Michaelis-Menten, by using Predefined Functions section on the dialog easily. 

 See also: Edit Reaction / Add KineticLaw section. 
 

1. After checking all the reactions and KineticLaw formulas, close the KineticLaw 
dialog and the Reaction dialog. 

2. You can double check all the specified Reactions, Parameters, etc in the List area. 
3. Select Simulation – Control Panel from the Menu, then conduct the simulation. 

 
 See also: “Running CellDesignerTM Simulation with ControlPanel” in the 

/documents directory. 
 
Reference: MAPK.XML 

 
id Math 

J0 V1 * MKKK / ((1 + pow(MAPK_PP / Ki, n)) * (K1 + MKKK)) 
J1 V2 * MKKK_P / (KK2 + MKKK_P) 
J2 k3 * MKKK_P * MKK / (KK3 + MKK) 
J3 k4 * MKKK_P * MKK_P / (KK4 + MKK_P) 
J4 V5 * MKK_PP / (KK5 + MKK_PP) 
J5 V6 * MKK_P / (KK6 + MKK_P) 
J6 k7 * MKK_PP * MAPK / (KK7 + MAPK) 
J7 k8 * MKK_PP * MAPK_P / (KK8 + MAPK_P) 
J8 V9 * MAPK_PP / (KK9 + MAPK_PP) 
J9 V10 * MAPK_P / (KK10 + MAPK_P) 
id Math 
J0 V1 * MKKK / ((1 + pow(MAPK_PP / Ki, n)) * (K1 + MKKK)) 

 
Species 

id initialQuantity 
MKK 280 
MKKK 90 
MAPK 280 
MKKK_P 10 
MKK_P 10 
MKK_PP 10 
MAPK_P 10 
MAPK_PP 10 

 
Parameters 

id name value 
V1  2.5
Ki  9
n  1
K1  10
V2  0.25
KK2  8
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id name value 
k3  0.025
KK3  15
V0 V0 111
K0 K0 1
k4  0.025
KK4  15
V5  0.75
KK5  15
V6  0.75
KK6  15
k7  0.025
KK7  15
k8  0.025
KK8  15
V9  0.5
KK9  15
V10  0.5
KK10  15

7.5 Simulation by COPASI 

COPASI（http://www.copasi.org/）is a software application for simulation and analysis 
of biochemical networks. COPASI is free for Non−Commercial Use.  
 
7.5.1 To setup COPASI to use with CellDesigner 

1. Visit the Copasi web site at http://www.copasi.org/. 
2. Download the Language Binding for Java  

(e.g. copasi-java-buildxx-win32.zip for Windows 32bit). 
3. Extract the downloaded file. 
4. In the extracted folder, find 

CopasiJava.dll for Windows. 
libCopasiJava.jnilib for MacOS X. 
libCopasiJava.so for Linux. 

5. Copy the file into the CellDesigner’s root folder. 
 
7.5.2 To simulate a model with COPASI 

1. Open the sample file “MAPK.xml”. 
2. On the Simulation menu, select COPASI GUI. 
3. The Copasi Time Course Simulation dialog will open. 

http://www.copasi.org/�
http://www.copasi.org/�
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4. Change Duration value to “1000”. 

 
5. Click Run. 
6. In the Time Course Result window, compare the result with the section “7.1 

Simulation by Control Panel”. 
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8. Gene / RNA / AntiSenseRNA Structure Expressions 

The graphical notation is extended and redefined to enhance representation capability 
for transcription and translation processes. The most salient feature is capability to 
describe promoter structure, and other detailed structure for genes and RNAs. 

 
 

 See also: [Appendix 2: Sample Files for Graphical Notation]. 

8.1 Promoter Structure Representation 

CellDesigner allows users to define the structure of promoter regions. Specific promoter 
regions are represented on upper part of the box. When such structure information is 
defined, lines for both sides and lower part of the box are either not shown or dimmed to 
highlight structures represented on the upper line. 
 
8.1.1 Symbols related to transcription and translation 

 

 
 
8.1.2 A usage example transcription related symbols 
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8.1.3 To specify region symbols 

1. Right-click on a Species. 
2. Select Edit <Gene or RNA or asRNA>… from 

the menu. 
Alternatively, select the Species from the 
List area and click the add button. 

3. In the Modification Region dialog, select a 
type from the drop-down menu and 
change the size and position. 
 

4. Click Close. 
5. Click Update. 

 
8.1.4 To change the modification of the modification site of a Gene 

1. Right-click on a Gene. 
2. Select Change Identity… from the menu. 
3. Click the target empty region and change the modification status from the 

drop-down menu. 

 
4. Click Apply. 
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8.2 Alternative Splicing 

Alternative splicing can be represented as transition of an RNA in the original state to 
multiple RNAs with different splicing patterns. 

 

8.3 Identification of Gene, RNA, and AntiSenseRNA. 

In the model, Genes, RNAs and AntiSenseRNAs are identified by their name. If the name 
of the newly created component is already used in the model, the representation will 
become the same as the existing one. 
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9. Layer 

You can add a layer to give comments to the components. The “base” layer is the layer 
where the components are displayed. Additional layers can hold free text to those 
components, or draw the circle or square. You can choose to display or to hide the layers. 

9.1 Add a Layer 

9.1.1 To add a layer 

1. Select Edit → Add Layer in the Menu. 
2. LayerNameInputDialog is displayed. 

3. Specify the Layer Name, then click Add Layer button. 
4. In the Layer area, find a new layer has been added to the list. 

 

9.2 Add Text and Shapes on a Layer 

9.2.1 To add a textbox to a component 

1. Select a component (Species, Reaction, or Compartment). 
2. In the Layer area, select the target layer. 
3. In the Menu, select Component→ Add Text. 

Or, right-click on the component and select Add Text. 
4. In the Input text dialog, type in any text, then press OK. 
5. The text is added to the specified component. 

      
 

http://celldesigner.org/help/helpwiki/lib/exe/detail.php?id=help%3Anewfeatures40&cache=cache&media=help:add_layer2.gif�
http://celldesigner.org/help/helpwiki/lib/exe/detail.php?id=help%3Anewfeatures40&cache=cache&media=help:add_layer2.gif�
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9.2.2 To add a Layer Object onto a layer 

1. In the Tool bar, select an icon out of the different Layer Objects. 

 
2. Place your cursor on canvas, click-hold the mouse button, and drag the cursor to 

the size and shape you like. 
9.2.3 To change the color and shape of a Layer Object 

1. Right-click on a Layer Object to open the Change Color & Shape... dialog. 
2. Change the parameters and click OK 

9.3 Manage a Layer 

9.3.1 To lock the Layer Objects on a layer 

1. In the Layer area, select a layer. 
 Note: The base layer cannot be locked, deleted nor set invisible. For it contains 

all the components (Species, Reactions and Compartments) and holds no Layer 
Objects in it. 

2. In the right-click menu, select Lock. 

 
3. Verify that all the Layer Objects on the layer cannot be selected. 

9.3.2 To set invisible the Layer Objects on a layer 

1. In the Layer area, select a layer. 
2. In the right-click menu, select Invisible. 
3. See that the Layer Objects belonging to the layer are invisible. 

9.3.3 To delete a layer 

1. In the Layer area, select a layer. 
2. In the right-click menu, select Delete Layer. 
3. See that the Layer Objects belonging to the layer have been deleted. 
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10. SBGN Viewer 

With the SBGN Viewer, you can readily obtain an SBGN graphical representation for the 
model created with the CellDesigner. 

 Note: CellDesigner’s SBGN Viewer adopts the SBGN Process Diagram Level 1 
draft as of May 2008. 

10.1 Use the SBGN Viewer 

10.1.1 To view a model with the SBGN Viewer 

1. Open a model. 
2. On the View menu, select Convert to SBGN Viewer. 

 Note: Difference In Graphical Notations---CellDesigner’s Original and SBGN 
There are some differences in graphical representation between the two. 

 CellDesigner SBGN Viewer 
Activated -> State Active   
In CellDesigner’s notation, activated 
proteins are surrounded by dotted line. 
(or open state for Ion_channel. 
In SBGN notation, activated proteins 
will have an oval at the bottom (States). 

  

• Protein–Generic type (activated) 
  

• Protein–Ion_Channel type 
(activated)   

Various Species Types -> Generic Species 
In SBML viewer, various Species shapes 
are represented by rounded square.   

• Protein –Receptor type 
  

• Protein –Truncated type 
  

• Protein –Ion_Channel type 
  

• RNA   
• Antisense RNA   
Clone Marker   
If a Species is duplicated on a map, it is 
indicated by using the clone marker 
(bottom part shaded) 

  

• Ion 
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• Simple molecule 
  

Resides/Domains etc -> Information box   
Gene / RNA / asRNA with  

Coding Region,  
Modification Site, 
Transcription Starting Site, 
and Regulatory Region 

  

Transcription / Translation   
Reactions of Transcription and 
translation are converted into the 
reactions with triggers. 

  

• Transcription  
 

• Translation  
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11. Limitations and Known Issues 

11.1 Limitations 

Available actions of UNDO and REDO are limited to actions making change on the draw 
canvas. 

11.2 Known Issues 

 The problems are reported in printing / exporting images of the huge model due to the 
lack of the memory. 

 When using CellDesigner in non-English environment on Mac OS X and Linux, letters on 
dialog boxes from File menu are not correctly displayed. 

 For Mac OS X, open “System Preferences” and click “International” icon from “Personal” 
row, and then click “Language” tab. In the window for choosing language, place “English” 
at the top. (Note: The terms quoted by “_“ depend on your environment.) Then start 
CellDesigner. 

 For Linux, unset LANG in the shell, then starts CellDesigner. 
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Appendix 1: Symbols and Expressions 

This section lists up all the symbols for building models with CellDesigner.  
Graphical notation and the list of the symbols are based on the proposals by Kitano: 

- "Using process diagram for the graphical representation of biological 
networks", Nature Biotechnology 23(8), 961-966 (2005).  

The symbol system for state-transition diagram and the residue state representation in 
these proposals are mostly realized with CellDesigner. 

 
 See Also: http://sbgn.org for SBGN (Systems Biology Graphical Notation 

scheme.) 

 
A sample file : Components40.xml 

 
 Note: All the graphical symbols used in CellDesingner will be found in the file 

“<your CellDesigner folder>/samples/components40.xml”. 

http://www.nature.com/nbt/journal/v23/n8/abs/nbt1111.html�
http://www.nature.com/nbt/journal/v23/n8/abs/nbt1111.html�
http://sbgn.org/�
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A1.1 Basic Symbols 

A1.1.1 Species 

There are 14 types of Species symbols. 
 
Species not activated activated 

Protein 
-Generic   

Protein 
-Receptor 

  
Protein 
-Ion channel 

  
Protein 
-Truncated 

  

Complex 

  
Gene 

 
n/a 

RNA 
 

n/a 

Anti-sense RNA 
 

n/a 

Phenotype 
 

n/a 

Ion 
 

n/a 

Simple Molecule 
 

n/a 

Drug 
 

n/a 

Unknown  n/a 
   

Tag 
 

n/a 
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A1.1.2 Modifications of Protein Residues 

There are 14 types of symbols for residue modification states. The residue symbols 
accompanied with their label (used for residue name and position in amino acid 
sequence) can be attached to all protein-type Species. 

 
Modification Symbol 

Phosphorylated 
 

Acetylated 
 

Ubiquitinated 
 

Methylated 
 

Hydroxylated 
 

Glycosylated 
 

Myristoylated 
 

Palmytoylated 
 

Prenylated 
 

Protonated 
 

Sulfated 
 

Empty 
 

Unknown 
 

Don’t Care 
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A1.1.3 State of Proteins 

New to Version 4.0: Now you can define the State of the Species. 
 

State Symbol 

Open 
 

Closed 
 

User defined 
 

 
A1.1.4 Modifications of Gene / RNA / AntiSenseRNA Residues 

There are 5 types of symbols for residue modification states. The residue symbols 
accompanied with their label (used for residue name and position in amino acid 
sequence) can be attached to Gene / RNA / AntiSenseRNA. 

 
Modification Region Symbol 

phosphorylated 
 

acetylated 
 

methylated 
 

Unknown 
 

Don’t care 
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A1.1.5 Compartment 

There are 4 types of Compartment symbols. For each type, the thick line indicates 
outside of its boundary. 

 
Type Symbol Note 

Square 
 

 

 

Oval 
 

 

Close-up type  
 

Northwest, Northeast 
Southwest, Southeast 

Close-up type  

 

West, East 
North, South 

 
A1.1.6 Reaction 

Symbols for Reactions are as follows.  

 
 

Reactions Symbol Note 

State Transition 
 

 

Known Transition Omitted 
 

Abbreviated symbol of several 
Reactions 

Unknown Transition 
 

 

Transcription 
 

 

Translation 
 

 

Transport 
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Reactions Symbol Note 

Heterodimer Association 

 

 

Dissociation 

 

 

Truncation 

 

Dissociation of Proteins by 
truncation. 

Add Reactant 

 

 

Add Product 

 

 

Degradation 
 

 

   
Modifications   

Catalysis 

 

 

Unknown Catalysis 

 

 

Inhibition 

 

 

Unknown Inhibition 

 

 

Physical Stimulation 
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Reactions Symbol Note 

Modulation 

 

 

Trigger 

 

 

 
A1.1.7 Logical Operation 

There are 4 types of Logical Operation symbols.  
 

Logical Operations Symbol  

And 

 

 

Or 

 

 

Not 

 

 

Unknown 
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A1.2 Expressions  

Here are symbols acquiring additional semantics by shape, combination of symbols, or 
change in drawings. 

 
Expression Symbol Note 

Active  

 

Select a Protein and, in the 
Component menu, select Set 

Active. 

Channel 
Open  

Select an Ion Channel and, in 
the Component menu, select Set 

Active. 

Species State  
Open / Closed 

 

   

Homodimer 
formed 

 

Double-click the Species to 
open the identity dialog, then 
set the Homodimer number. 

Complex 

 

Set Change Complex View to 
normal / compact / no border. 
 
compact is used to hide the 
contents of the Complex.  
 
no border is mainly used for a 
Complex with Genes etc. 

Complex in a 
Complex 

  

Hypothetical 
Species  

Double-click the Species to 
open the Change identity of the 

species dialog, then select 
hypothetical. 

Reversible 
Reactions  

Double-click the Reaction, 
then set Reversible to True. 

Bidirectional 
Reactions  

Simply draw two state 
transitions and reposition 
them. 
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Expression Symbol Note 
Homodimer 
Formation  

Click the icon of Homodimer 

Formation. 

Degradation 
of Species  

Click the icon of Degradation. 
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Appendix 2: Sample Files for Graphical Notation 

To explore new graphical notation scheme, there are sample files available in this version. 
Please open the files in the /samples directory and try editing the model. 

A2.1 Exapmples of the sample files contained in the CellDesigner 

/samples/M-Phase.xml 

 

/samples/M-Phase2.xml 

 

/samples/MAPK.xml 

 

/samples/sim2.xml 

/samples/Macros.xml 

 

/samples/notation/geneRNA40.xml 

 
/samples/notation/ReactionShape.xml 

 

/samples/notation/Complex40.xml 
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A2.2 Examples for Graphical Notation 

These are the examples used in the paper 
"The Process Diagram for Graphical Representation of Biological Networks," Kitano, H. 
et al. Nature Biotechnology, August 2005.  

 
Fig1b_ProcessDiagram_4 

 

Fig3abcd_AndOr_4 

 
Fig3e_EGFR_league_4 

 

SuplFig3_NF-kappaB(p65+p50)_4 

 
SuplFig2_GPCR beta2-AR_4 

 
 
SuplFig4a_TranscriptionTranslation
_4 

SuplFig4b_transcription_4 
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SuplFig5_StructureofComplex_4 

 

SuplFig7_M-Phase_4 
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A2.3 CellDesigner Species / Reactions Conventions 
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